®

Bar Code Printers ForThe 90's

M-8400S

Thermal Transfer Printer

Operator;s Manual

First Edition

Bid on Equipment B _
3-TT20

1-847-683-T7
www.bid-on-equipment.com



- M-8400S
Operator's Manual

Table of Contents

Section 1: Printer Overview
 §50% 5o Ts L6 Led A Te) s DU OO PP PPS 1-1
General Printer Specifications......c..ooiiiiiiiiiiiiiii e 1-1

Section 2: Setup And Configuration

| 3015 oo AT n 0 ) ¢ W PPN 2-1
Loading Label and Tag Stock........ccoviiuiiiiiiiiiiieni e 2-3
Loading RIbDOm....couiiiiii e 2-4
Using The Operator Control Panel..............c..oo 2-5
Selecting Printer Configuration..............ccoioiiiiiiiiiiiiii i 2-6
Main OCP Flowchart........oooiininiiiiii et 2-8
0TS . (s LT O PP PIPUPP 2-10
Password Protected Modes.......c.vuiiiiiriiiiiiiiii et 2-15

Adjusting the Print Quality (Darkness).........ccoceuveieieiiiiiiiiiiiiiiie e eenss 3-1
Cleaning the Print Head...........cooiiiiiiii 3-2
Cleaning the Platen, Demand Plate, and Rollers............cc..co.coo. 3-3
Replacing the Print Head...........coooiiiiiiii e 3-4
Replacing the Main Power FUuse.........coooiiiiiiiiiiii e 3-5
it SATO M-8400S Operator's Manual 7/93
Packaging - Processing
— Bid on Equipment
1-847-683-7720

www.bid-on-equipment.com



INTRODUCTION

GENERAL PRINTER SPECIFICATIONS

7/93

Section 1 — Printer Overview
SECTION 1
PRINTER OVERVIEW

The SATO M-8400S Thermal Transfer Printer is a high performance OEM printer engine
designed for simple integration into automatic label applicator systems. Printer operating
parameters are programmable either via input from the Operator Control Pan el (OCP)or
from the host via the interface (Both serial and parallel interfaces are built-in). All popular
bar codes and eight human readable fonts are resident in memory, including a vector font for
virtually thousands of typestyles and sizes.

The operating commands for the M-8400S are a super-set of those for the M-8400 table top
printer; software written for the table top printer may easily be adapted for use with the "S"
model.

This Operator's Manual will provide you with the basic operating instructions for setup,
configuration setting, ribbon and label stock loading and periodic cleaning.

Printing Method Thermal Transfer
Printing Speed Up to 5 inches (125mm) per second
Bar Code Symbology UPC-A, UPC-E, EAN-8, EAN-13, CODE 39,

I12/5, CODE 128, CODABAR, MSI, 2/5,
CODE 93, UPC Bookland

PCS Vvalue 75% minimum

Bar Code Ratio 1:2, 1:2.5, 1:3, or individually programmable bar
widths

Human Readable Fonts Eight fonts including OCR-A and OCR-B

representations and a vector font. American and
European character sets, upper and lower case with
decenders. Expandable in 12 independent steps
horizontally and vertically.

Flexibility 360° rotation of bar codes and text in four 90° steps.
RAM Storage for special characters, dot addressable
graphics, sequential numbering. Form overlay for
high speed editing of complex formats.

Sensing Adjustable photo-electric sensor.
Transmissive sensor for die cut labels & tags.
Reflective sensor for use with sense marks (I-Marks).
Automatic or manual setting of top of form.
Continuous form printing.

Media Die cut labels, plain paper stock, SATO standard or
equivalent.
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Section 1 - Printer Overview

Media Size

Interface

Data Transmission

Applicator Control Signals

Dimensions
Weight

AC Power

Environment

Maximum Print Area

Print Module

Display

Approvals

1-2 SATO M-8400S Operator's Manual
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Tag stock, SATO standard or equivalent with punched
feed slot for "see through” sensing.
Tag caliper: 0.010 in (0.25mm) maximum.

Minimum: 1 inch (25mm)W x 0.25 inch (6.35mm)L
Mazximum: 5 inches (125mm)W x 14 inches (360mm)L

RS232C Serial, 300-19,200 BPS
* Hardware (DTR) flow control
* Software (X-ON/X-OFF) flow control
¢ Bi-Directional (ENQ/Response)
Parallel (Centronics compatible)

ASCII

+5V

Carbon Near End signal
Machine Error

Start Print command
Print End signal

Label Out signal
Ribbon Out signal
Signal ground

11.8 (300mm)H x 10 (255mm)W x 14.4 (365mm)D
251bs (11.34kg)

100V-115V (+10%)
220V (£10%)
50/60Hz

Idling: 50W
Operating: 300W

Operating: 50-95°F (10-35°C)
15-85% RH, non-condensing
Storage: 0-130°F (-20-55°C)

90% RH, non-condensing, maximum
4.1 inches (104mm)W x 14 inches (360mm)L

M-8400S /8: 0.005 (0.125mm) square
M-8400S /6: 0.0066 (0.167mm) square

LED indicators: POWER, LABEL, RIBBON,
ERROR, DATA, ON LINE
LCD display: 2-Line printer status and configuration

FCC Class A

U/L
CSA

7/93
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Section 2 — Setup and Configuration

SECTION 2
SETUP AND CONFIGURATION

INTRODUCTION

This section provides you with instructions for:
* Loading label and tag stock
Loading ribbon
Using the Operator Control Panel (OCP)
Setting printer configuration
- General Flowchart of the M-8400S
- User Mode (Mode U)
Password Protected Modes
- Interface Mode (Mode I)
- Setup and Accessory Mode (Mode S)
- Counter Mode (Mode C)
- Memory Mode (Mode M)
- Test Print Mode (Mode T)

- Watch Mode (Mode W)
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Section 2 — Setup and Configuration
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Figure 2-1 Label and Ribbon Routing
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Section 2 — Setup and Configuration

LOADING LABEL AND TAG STOCK

10

11

12

13

Note:

ACTION

Raise the front cover to the full upright position.
Rotate the Print Head Lever to the open position. (See Figure 2-1.)
Adjust the label edge guide to its widest setting. (See Figure 2-1.)

Manually feed 3 feet of label stock, face up, through the label sensor and between the print
head and the platen. Allow label stock to extend beyond the right side of the printer.

Rotate the Print Head Lever to the closed and locked position.

Remove and discard all labels from the backing paper extending to the right of the print
head.

Rotate the Pinch Roller Control to the OPEN position. (See Figure 2-1.)

Manually feed the backing paper over the Demand Plate then between the Platen and the
Pinch Roller, towards the left, until all slack is removed. (See Figure 2-2.)

Rotate the Pinch Roller Control to the CLOSED position.

Attach the leading edge of the backing paper to the backing paper rewind mandrel following
the instructions included with the applicator. Manually rotate the mandrel in the wind
direction until all slack is removed from the backing paper.

Adjust the position of the label edge guide to align it with the outside edge of the label stock.
Visually examine the labels to verify that they are loaded as shown in Figure 2-1.

Lower the front cover to the closed position.

The printer will not operate unless the front cover is in the fully closed position.
FOR YOUR CONTINUED SAFETY DO NOT OVERRIDE THE FRONT COVER

INTERLOCK SWITCH.
/ Print Head

Demand Plate

Backing Paper

/ ‘ Printed Label
Pinch Roller Control

Figure 2-2. Label and Ribbon Routing Closeup View
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Section 2 — Setup and Configuration

LOADING RIBBON

NOTE:

10

Note:

ACTION
Raise the front cover to the full upright position.

Rotate the Print Head Lock lever to the open position.
Install an empty ribbon core onto the ribbon rewind mandrel. (Use the core which was
included with the printer or one from a previously used ribbon. Always save the empty

ribbon core)

Place the new roll of ribbon onto the unwind mandrel with the unwind direction as shown in
Figure 2-3.

The dull surface of the ribbon must face the label stock.

Carefully thread the leading edge of the ribbon beneath the guide roller, through the ribbon
sensor, and between the print head and the platen.

Attach the leading edge of the ribbon squarely to the rewind core using a 1 inch length of
common paper or plastic tape. Verify that the rewind direction is as shown in Figure 2-3.

Manually rotate the ribbon rewind mandrel/core in the direction shown in Figure 2-1 to
remove all slack in the ribbon and wrap 2-3 turns around the rewind core.

Rotate the Print Head Lock lever to the closed and locked position.
Visually examine the ribbon to verify that it is loaded as shown in Figure 2-1.
Lower the front cover to the closed position.

The printer will not operate unless the front cover is in the fully closed position.
FOR YOUR CONTINUED SAFETY DO NOT OVERRIDE THE FRONT COVER

INTERLOCK SWITCH.

Ribbon Unwind Mandrel
New Ribbon

Ribbon Rewind Mandrel

Ribbon Core

Tape

Figure 2-3. Ribbon Loading Closeup View
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Section 2 — Setup and Configuration

—

The Operator Control Panel (OCP) on the M-8400S consists of a 2-line LCD alpha-numeric
display, LED indicator lights, switches, and adjustments. Adjacent to the OCP is the main
A-C power switch. These dispays, indicaors, and switches inform you of the printer's operat-
ing conditions and allow you to select the required printer configuration. Review Figure 2-3
below to familiarize yourself with the location of the features of the OCP.

@ DISPLAY @
o)
— POWER  LABEL RIBBON ERROR DATA S:E k J k J L J

® o o O O 0] O ®
Feature Function
POWER When illuninated, indicates that A-C power is ON
LABEL When illuminated, indicates label out condition
RIBBON When illuminated, indicates ribbon out condition
ERROR When illuninated, indicates that a printer error condition exits
DATA — Not Used -

ON LINE When illuminated, indicates the ON LINE state

DISPLAY Contrast adjustment for LCD panel

PRINT Fine adjustment of print image darkness

LINE Alternate action switch for selecting ON LINE and OFF LINE states

FEED Advances one label for each action

F1 Retreats one configuration step for each action

ENTER Enters the selection on the LCD/ advances one step for each action
Selects the previous configuration item for each action

| 2 Selects the next configuration item for each action

FIGURE 2-4. OPERATOR CONTROLPANEL

7/93 . SATO M-8400S Operator's Manual 2-5
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Section 2 — Setup and Configuration

SELECTING PRINTER CONFIGURATION

The controls, indicators, and alpha-numeric display on the Operator Control Panel are used
to configure the printer, customizing it meet your printing requirements. For example, using
the controls and display you can specify which interface type to use.

All operational selections are grouped together under specific modes which are listed the
following chart. For instance, Mode U (User Mode) contains only those selections that
pertain to the user, whereas Mode S (Setup Mode) contains selections that may be used to
configure the printer to your requirements.

Modes I, S, C, M, T, and W cannot be accessed without first entering a password and are,
therefore, considered password-protected modes. Instructions for establishing a password
are located in the description of Mode S.

Refer to Figure 2-3 for the location and function of each feature within the OCP.

2-6 SATO M-8400S Operator's Manual 7/93
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Section 2 — Setup and Configuration

M-8400S Mode Selection Chart

Password Protected Modes
Mode U Mode 1 Mode S Mode C | Mode M Mode T Mode W
(User) (Interface) | (Setup) (Counter)| (Memory) (Test Print)| (Watch)
Print I/F Type Sensor Head Copy Mem Receive Year
Darkness Counter | Card Buffer
Print Receive Pitch Lifetime | Set Card Format Month
Speed Buffer Detect Counter | Type Numbers
Size Method

Pitch Proto- Print User Clear Mem | Stored Day
Offset Codes Method Counter | Card Graphics

Carbon Custom Hour

Saving Designs

Dispenser Head Minute

Pattern

Pitch Built-In

Offset Fonts

VH Vector

Offset Fonts

Head Printer

Check Settings

Loopback Bar Codes

Test

SATO

Defaults

User

Defaults

External

Signals

Backfeed

Password

7/93
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Section 2 — Setup and Configuration

MAIN OCP FLOWCHART

The chart below illustrates the flow of input by the operator for the Operator Control Panel

(OCP). Detailed flowcharts for each mode appear on the following pages.

QTy
0000

OFFLINE

!@“

[Select a Mode]
Mode U

Press Enter To
Continue

T

Enter Password
[o00]

I_

_.I

[Select a Mode] I

o5

oo

[Select a Mode] |

0 6

[Select a Mode]
Mode T

|__

oo

[Select a Mode]
Mode W

@b—l OFFLINE

Figure 2-4. Main OCP Flowchart
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Section 2 — Setup and Configuration

USER MODE

The following chart shows the general flow of the configuration for Mode U. Each shaded
box represents the staus of the operator panel's LCD display. The symbols between the

boxes represent the operator keys that, if pressed, will take you forward or backward
through the mode's available selections.

Mode U

(On-line)

ary

0000
LINE A LINE
3.

OFFLINE

ENTER A F1
5y |

4‘.._........-‘ aaaaaaaaaaaaaaaaaaaaaaa ‘
ENTER A P F P F1

 SetDarkness ‘Set Print Speed | SetPitch Oftset

v
v
Ov

The ENTER key, arrow keys, and F1 key are used throughout this manual to proceed down-

ward, horizontally, or upward through the options and values. Basically, the keys are used
as follows: '

ENTER Used to select an option from the display and move down to the next menu

level. Also used to set a value into the printer configuration.

Used to proceed horizontally (left or right) through a series of values,
remaining on the same level until the desired value is displayed.

4
O

Oz OV

Used to proceed upwardward (i.e., backward) to a previous level.

2-10 SATO M-8400S Operator's Manual 7/93
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Section 2 — Setup and Configuration

Mode U
Print Darkness

Set >
Darkness D
ENTER
I | l |
Print at Which b Print at Which b Print at Which b Print at Which b Print at Which >
Darkness? 1 D Darkness? 2 D Darkness? 3 D Darkness? 4 Darkness? 5 D
ENTER .
When the desired value
' is displayed, press ENTER
Option Definition/Purpose Values/Settings
Print Darkness | To set the darkness of the print on the label. 5 Darkest
This option should provide adequate flexibility. | 4
If the darkenss needs further adjustment you 3
may use the adjustment on the operator panel.| 2
1 Lightest
* SATO factory default
7/93 SATO M-8400S Operator's Manual 2-11
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Section 2 - Setup and Configuration

Mode U
Prmt Speed & Pitch Offset
Set
Print Speed »
ENTER O
D Set Pitch
Offset
| | | ENTER
Print st Which b Print st Which > Print at Which b Print st Which > D
Speed? S0mm/s D Speed? 75mm/s D Speed? 100mm/s D Speed? 125mavs D '
l — |h I Use the arrow ":Lm“’..."'
'hen the ENTER keys to enter I
desired value  [] Y the desired T
is displayed, . value then
press ENTER [Select A Mode} press ENTER.
Mode U [Select A Mode}
Mode U
Option Definition/Purpose Values/Settings
Print Speed To set the speed at which the labels are 50 mmvs
printed. 75 mmvs
100 mmnvs*
125 mmv/s
Pitch Offset To adjust the position of the leading edge of +00 mm*
the label forward/backward from the normal (-50 mm to +50 mm)
stop position under the print head.
(if the scale is set to dots from
A positive value moves the leading edge withinMode S, then the range is
forward, lowering the starting print position. A| -400 dots to +400 dots.)
negative value moves the leading edge
backward, raising the starting print position.

* SATO factory default
2-12 SATO M-8400S Operator's Manual 7/93
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Section 2 — Setup and Configuration

Detailed Mode U Configuration Instructions
The following pages illustrate the sequence and steps for making all selections within Mode U.

Panel Displays: Press Key: Comments

Printer is on-line. Pressing LINE takes the
Qty [L_I_INE printer off-line, which allow you to begin
0000 configuring.
Offline ENTER When in the off-line state, pressing ENTER
O advances to the User Mode (Mode U). To
return to the on-line state, press LINE.
[Select A Mode} ENETE]ER E] E] Press ENTER to progress to Mode U.
or
Mode U Alternately, use the arrow keys to move to
additional password protected modes.
: , . This option is a primary adjustment for the
< Mode U Options > ENTER N , :
Set Darkness 0 darkness of print. Press ENTER to display
darkness values.
Alternately, use the arrow keys to move to
additional Mode U options.
4 ) Use the arrow keys to move through darkness
ENTER
It W hich O o OO values 110 5. (5 is the darkest, 1 is the
lightest, tactory default is 3.)
Press the ENTER key when the desired
darkness value is displayed. Pressing
ENTER will also advance to the next Mode U
option.
: This option allows selection of print speed.
< Mode U Options > ENTER 4 ) h X
Set Print Speed 0O or ] Press ENTER to display print speed values.
Alternately, use the arrow keys to move to
additional Mode U options.
7/93 SATO M-8400S Operator's Manual 2-13
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Section 2 — Setup and Configuration

Panel Displays: |

Press Key:

Comments

Print at Which
Speed? 100mm/s

ENTER

4>
or [J 0

Use the arrow keys to move through print
speed values 50, 75, 100, and 125 mnv/s.

Press ENTER when the desired speed is
displyed. Pressing ENTER will also advance
to the next Mode U option.

< Mode U Options >
Set Pitch Offset

ENTER
or

Ca
v

Use this option to adjust the position of the
leading edge of the label relative to the print
head. Press ENTER to display pitch offset
values.

Alternately, use the arrow keys to move to
additional Mode U options.

Enter Offset
+00mm

ENTER <
or

Oov

Use the right arrow key to display positive (+)
offset values and the left arrow key to display
negative (-) offset values.

Press the ENTER key when the desired offset
value is displayed. Pressing ENTER will also

advance to the next Mode U options.

(Select a Mode)
Mode U

Press F1 to return to the OFFLINE state.

Alternately, pressing F! from any Mode U
option selection will return to:
[Select a Mode] Mode U.

Offline

LINE

Press LINE key to return to the ONLINE state.

0000

2-14 SATO M-8400S Operator's Manual

The printer is now ready to print. You have
completed Mode U configuration selections.
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Section 2 ~ Setup and Configuration

PASSWORD PROTECTED CONFIGURATION MODES

Detailed Instructions for Accessing Modes |, S,C, M, T, and W

The chart below illustrates the process for accessing the first level of the password protected
protected modes 1, S, C, M, T, and W. For further instructions on the selection and use of the
options within each mode refer to the following charts and diagrams.

Panel Displays:

Press Key: Comments

Qty
0000

Printer is on-line. Pressing LINE key takes the
LINE printer off-line, which allows you to proceed
with configation selections.

Offline

ENTER When in the off-line state, pressing ENTER
advances to the User Mode (Mode U). To
return to the on-line state, press LINE.

[ Select A Mode ]
Mode U

Press right arrow key to advance past

>
O Mode U.

Oa

Press Enter to
Continue

Press ENTER to progress into the Password

ENTER
Protected Configuration Modes.

Enter Password
000

Use the arrow keys to move through numbers
000 — 999 to display the password.
(SATO factory defalult password is 000. Set

ENTER
or

Ca
Oovy

custom pasword in Mode S.)

Press the ENTER key when the desired
password is displayed. Pressing ENTER will
also advance to Mode |. Each additional
pressing of the ENTER key will advance to
the next Pasword Protected Mode (S, C, M, T,
and W)

< Select a Mode >
Mode |

ENTER 4 ) Press either arrow key to advance through all
or 0O Password Protected Mode selections.

7/93

Press ENTER when the desired mode is
dispalyed.
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Section 2 — Setup and Configuration

Mode |

Qy

0000
E}NE ¢ ‘ ﬁNE

OFFUNE  fo—m e oe e e — —_——
ENTER A F1 ‘_ |

—aff——— Press Entt;r
ModeU | 7. = 'Torcontinue

Enter Password
{000]

ENTER

Use arrow keys
change the value
then press ENTER

N Press F1 from any
—_——— Mode I option to return

F1 to the Mode I Main

D menu.
- F1
‘Mode | il snranananann D

'

Setup Set Rev Buf Set
interface Type ‘ > Size ‘ > ‘Proto-Codes ‘ b
00 00O 0O
2-16 SATO M-8400S Operator's Manual 7/93
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Section 2 - Setup and Configuration

Mode |
Interface Type
Setup
Interface
ENTER

| ]
Select Interface > Select Interface >
RS232C D CENTRONICS

ENTER ENTER

finished

Change RS232C b Change RS232C b Change RS232C > Change RS232C b Change RS232C b Change Muiti- b

Baud Rate D Stop Bit Length D Parity Data Bit Length Protocol D Drop Printer No. D
ENTER| JENTER ENTER ENTER ENTER Not Used
Set Protocol To b Set Protocol To b Set Protocol To > Set Protocol To > Set Protocol To >
PC1 RSOn D PC1 RS On/Oft D Xon/Xoft D Status 1 D Status 2 D

| ] ] ]

ENTER
finished 0

|

Set Data Bits To b Set Data Bits To b

7 Bits D 8 Bits D
1 |

ENTER
finished D

Set Data Parity b Set Data Parity > Set Data Parity ’

To No D To Even D To Qdd D
| | ]

ENTER
finished 0
i

]
Set Stop Bit To > Set Stop Bit To >

1 Bit D 2 Bits D

| ] Set Baud Rate

To19200BPS [
ENTER
finished v ™ >

| O]
Set Baud Rate Set Baud Rate b Set Baud Rate b Set Baud Rate b Set Baud Rate b Set Baud Rate

>
To 300 BPS D To 600 BPS D To 1200 BPS D To 2400 BPS D To 4800 BPS D To 9600 BPS
1

Ov

ENTER
finished

7/93 SATO M-8400S Operator's Manual 2-17
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Section 2 — Setup and Configuration

. Model
Interface Type

‘Option | Definition/Purpose - Values/Settings |

Interface To indicate which interface will be used to Centronics Parallel
communicate with your host computer RS232C*

It RS232C is selected, you must set the If RS232C:
following values:

» Baud Rate Baud Rate Values:

* Stop Bit 300 Bps 4800 Bps
* Parity 600 Bps 9600 Bps”*
» Data Bit 1200 Bps 19200 Bps
* Protocol 2400 Bps

* Multi-Drop Printer

Stop Bit Values:
1 Bit*
2 Bits

Parity Values:
No*

Even

Odd

Data Bit Values:
7 Bits
8 Bits*

Protocol Values:

PCt RS On*

PC1 RS On/Oft
XorvXoff

Status 1 — Reserved
Status 2 — Bi-Directional

Note: See Programmer and
Technical Reference Manual,
Section 2 — Interface
Specifications for more details on
RS232 protocols

Multi-Drop Printer Values:
Reserved for future use.

* SATO Factory Default
2-18 SATO M-8400S Operator's Manual 7/93
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Section 2 — Setup and Configuration

Mode |

Receive Buffer Size & Proto-Codes

Set Rev Buffer Set
Size > Proto-Codes
ENTER O ENTER
D +
| |
Set Buffer Size > Set Buffer Size > Set Proto-Codes b Set Proto-Codes b
To 1-ltem? D To 10 item? D To Standard? D ITo Non-Standard 1 D
ENTER _ When the desired ENTER
[ finished value is displayed, finished
press ENTER
When the desired
value is displayed,
press ENTER
Option Definition/Purpose Values/Settings

Proto-Codes

Receive Buffer | To indicate the size of the job buffer. A print

job is defined by a START command at the
beginning and a STOP command at the end of
a data block.

To select which Proto-Code set will be used in
the data stream to the printer.

See the begining of Section 1 of the
Programmer and Technical Reference manual
for a list of each Proto-Code set.

1-item Buffer* — The printer can
process only one print job at a time
and is busy until completion.
10-item Buffer — Allows upto 10
print jobs to be sent in one data
stream.

Standard*
Non-Standard

7/93
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Section 2 — Setup and Configuration

Setup and Accessory Mode
Qry
0000 »
LINE ‘ LINE
O n
OFFLINE il A
ENTER B
0 QH 3
_ 0 i
MODE U ' ‘-||||| ............ anﬁzmr'ro
> ENTER A F1
D Enter Paswcm-!
©00)
............................. i
EN&EIR‘ ‘ F1
Use arrow keys y : [ >
change the value MODE ¢ MODES  filllfesssssssmmsersssssnsssaraassan :
then press ENTER O £
i P F1fi
ress rom any
= ' i 1 Mode S option to
return to the Mode S
i Main menu. >
Setuwp b Set Pitch > Set Print b Set Carbon ’ Spt D
Sensor D Detection D Method D Saving D Dispenser ‘I
>
P > e S ey S rperes > [ Y
Ofis Offset Check Test Detfautts
- O - O O O ‘I
Set User > Set External b Backfeed > Set b
Defauls D Signal D D Password D
2-20 SATO M-8400S Operator's Manual 7/93
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Section 2 — Setup and Configuration

—
Mode S:
Sensor
Set —
Ser:r >
ENTER D
Ol
L | |
Use Sensor No > Use Sensor No > Use Sensor No
123 D 4.5 6
ENTER ENTER ENTER
O O O When the selection you want
finished finished is displayed, press ENTER
Sensor4 E Not Used E Reserved E Sensor 5 E
| 1
EN[T]ER
To Set Threshold
1st Input = 00
EN&ER
o To Set Threshold
2nd input = 00
EN&}’ER*
{ |
Thresholkd = 00 ’ Threshold = 00 >
Is it OK? No is It OK? Yes 0
ENTER
finished
Option Definition/Purpose Values/Settings
Sensor There are 6 label sensors in the M-8400S. Each 1,2,3 (Tag Hole/Notch)
sensor detects the leading edge of the label to 45" (See Through & Reflective)
properly align the position the printed image. 6 (Center Hole)
Use Sensor 1, No calibration required N/A
2,3,6
Use Sensor 4 Calibration required to distinguish between the istinput =00V
the label and the gap. For use with die cut stock. 2nd input = 00 V
Threshold must be 2.2 volts or greater. Threshold = 00 V
Use Sensor 5* Calibration required to distinguish between the 1stinput = 00V
-~ the backing paper and the |-Mark. For use with 2nd input = 00 V
but-cut stock. Threshold must be 2.2 volts or Threshold = 00 V
greater.
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Section 2 - Setup and Configuration

Label Sensor Adjustment

The position of the label sensor is adjustable to match the position of the feed slots (notches) or I-Marks on
your labels and tags. Rotate the knob identified below to adjust the position of the sensor. Use the data shown
when designing labels and tags to ensure correct placement of the leading edge indicator.

Front View of Label Sensor

S 4321 6 1, 2, 3, 6= Tag Hole/Notch Sensor
= Transmissive Sensor
Reflective Sensor
l
CCw =
13 Base Plate to
mmn Inside Edge

Die Cut Inter-Label Gap
3mm Nominal

I-Mark' -
{(on back)

\ Reflective Sensor (5) Range:

S5mm, Full CCW; 25mm, Full CW
}4.__>| )
AN g
Transmissive Sensor (4) Range: S
10mm, Full CCW; 30mm, Full CW g
. ~
Backing | " > 8
Paper g
Inside ag Hole Sensor (1,2,3) Range: =

Edge 156mm, Full CCW; 40mm, Full CW

Tag Notch Sensor (6)

Range: 52mm, Full CCW,
72mm, Full CW

Label Inside Edge

Dot Column Number

Ry

4

RN T
e
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Section 2 — Setup and Configuration

. Location of Label Sensor and Adjustment Knob.

It Sensor 4 (See-Thru) or Sensor 5 (Reflective) is choosen during the use of the Sensor option in Mode S, setting
of the threshold values will be required to complete the configuration setup.

The printer calculates a threshold voltage based on the amount of light (resulting voltage generated) passing
through the label and the amount passing through the inter-label gap or reflected back from the label and I-Mark.
When detected, this threshold voltage indicates the leading edge of the next label.

You must manually position the label and then the inter-label gap in the sensor's field of vision and record
(ENTER) the resulting voltage reading. Use the instructions in the following chart and the illustration above to
complete this procedure.
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Section 2 — Setup and Configurqgtion

To Set Threshold
1st Input = 3.0V

To Set Threshold
2nd Input = 0.2V

Threshoid = 1.6V
Is it OK? No

2-24 SATO M-8400S Operator's Manual
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When the message shown on the left is displayed on the printer,
1. Open the print head assembly by rotating the lever to the
"head open" position.

2. Manually adjust the position of the_label in the sensor until the
highest Threshold voitage level is displayed. (This should result
in a voltage of approximately 3.0V.)

3. Press <ENTER>.

When the message shown on the left is displayed on the printer,
1. Manually adjust the position the jnter- label gap in the sensor
until the lowest Threshold voltage level is displayed. (This should
result in a voltage of 1.0v or less.)

2. Press <ENTER>.

If the threshold value displayed on the printer is 1.5 volts or
greater, press either arrow key until the display is "Yes" and then
press <ENTER>.

if the threshold value is less than 2.2 volts, press either arrow key
until the display is "No", press <ENTER>, and repeat the above
steps.

Note:
The threshold value should be 1.5 volts of greater for consistant
label feeding/printing.

Failure to achieve this minimum threshold value is usually the

. result of overly transparent iabel stock or overly opaque backing

material.

7/93
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Section 2 — Setup and Configuration

Mode S
Pitch Detection & Print Method

Set Pitch Detect Set Print Method
>
ENTER O ENTER
Pitch Data From b Pitch Data From b Pitch Data From b Set Print Method b Set Print Method >
Auto Sensing? D “dot" Scale? D "mm" Scale? D To: Transter D To: Direct D
ENTER ENTER ENTER | |
D Y D D Ef‘ﬁﬂ When the desired
) . , value is displayed,
finished Emesr4 ZuézgtsData Enter;o::wn Data press ENTER
finished
Er\Er]ER * EN[T]ER *
Use the arrow keys
to change the value
and press ENTER
Option | Definition/Purpose = | Values/Settings

Pitch Detection | To indicate the method by which the printer will | Auto Sensing* — The printer
determine the top of form (label leading edge). | automatically determines label
length. it will feed 2 or 3 labels
each time the printer is powered on
or label stock is changed.

"dot" Scale — The label length will
be determined by a user entered
dot value. Value range = 0000 to
2000 dots. 640 is Factory Default
value. (See next page.)

"mm" Scale — The label length will
be determined by a user entered
mm value. Value range = 000 to
178 mm. 050 is Factory Default
value.

Print Method To indicate the method by which the labels are | Thermal Transfer* — Method of

printed. Printer makes adjustments in the printing using a carbon-based
amount of heat applied based on the method ribbon on standard label stock.
chosen. Direct Thermal — Method of

printingusing special heat sensitive
label stock. No ribbon is required.

* SATO factory default
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Section 2 ~ Setup and Configuration

Dot Scale

When determining the label length using the dot scale method, begin by measuring from the leading edge of one
label to the leading edge of the next label.

(. 4

\— \

-t L >

Leading Edge Leading Edge

It the label length from one leading edge to the next leading edge is 3.15 inches or greater, set the dot scale to
640 dots (479 for the M-8400/6 S printer).

If the label length from one leading edge to the next leading edge is less than 3.15 inches, use the formula below
to determine the dot scale value:

Dot Scale Value Formula: [3.15 - N (L)] x 203*
“Where: N ‘Number of whole labels (leading edge to leading edge) that will fit into 3.15 inches.
N = (3.15 + L) - remainder

L Label length from leading edge to leading edge (in inches).

Example: Label length = 1.25"

1. Calculate N (The number of whole labels that will fit within 3.15 inches):

N = (3.15 + 1.25) - remainder
N = 2.52 - remainder
N=252-052
N=2

2. Multiply the number of whole labels by the label length from one leading edge to the next:
2x1.25 = 2.5 inches

3. Subtract the total from Step 2 from 3.15 inches
3.15-25=0.65

4, Convert 0.65 inches to dots:
0.65 inches x 203 dpi = 132 dots

5. Set Dot Scale Value to 132 dots

* For M-8400/6 S use 152 instead of 203
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Section 2 — Setup and Configuration

Mode S:
Carbon Saving

Set Carbon
Saving
ENTER ‘
] ]
Use Carbon Saving > Use Carbon Saving >
Mechanism? No D Mechanism? Yes D
I |
ENTER
finished

When the value you want
is displayed, press ENTER

Option Definition/Purpose Values/Settings

Carbon Saving To indicate the use of the ribbon (carbon) saver

No* — Disables use of Ribbon Saver

option. Yes — Enables use of Ribbon Saver

Note: The M-8400S Ribbon Saver is a factory
installed option to the printer. See the
Programmer and Technical Reference manual,

Appendix E.
* SATO Factory Default
7/93 SATO M-8400S Operator's Manual 2-27
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Section 2 — Setup and Configuration

: Mode S: :
Dlspenser & Pitch Offset
s - >
D:mw | SetPitch Oftset
> ENTER D
ENTER 4 O 0 ‘
O | | l
Use Dispenser? > “‘Use Dispenser? b Set Offset Scale > Set Offset Scale ’
No Yes D To *mm"2? D To “dot*? D
ENTER ENTER L ]
] [l ENER
|
Dispense > Dispense > finished
by Pulse by Sensor D
ENTER ENTER
O O
inish finished When the selection you want
finished is displayed, press ENTER
Option Definition/Purpose Values/Settings
Dispenser To select the dispenser feature for use with ~ No* - Selects continuous printing
an applicator system. Must also select Yes — Selects Demand printing
Dispense by Pulse. (See below)
Dispense by To allow the applicator to control the printing Prints one label each time Pin 5 of
Puise of labels the applicator connector (I F)is
switched to Ov (ground).
Dispense by To allow continuous printing of labels Not applicable to “'S" model printers,
Sensor Note: Not used with applicator systems. do not use.

2-28 SATO M-8400S Operator's Manual
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Section 2 — Setup and Configuration

Mode S
VH Offset, Head Check & Loopback Test
Requires special
connector
Set VH Offset Set Head Check ?o %oopback
> b es ]
ENTER O ENTER O ENTER
O + O ‘ Ol ‘
Enter Ver Offset r l finished
>0000 dats Are You Sure? b Are You Sure? b
Er\&ER Use the arrow keys No O L[Ye O
to change the value
and press ENTER ENéER ENTER
Enter Horiz Offset
>0000 dots fnished Q:‘,‘:,,ff" mwd
ENTER Use the arrow keys to 0001 Y
change the value and
press ENTER ENTER Use the arrow Keys to
change the value and
finished press ENTER
finished
Option Definition/Purpose Values/Settings
VH Offset To adjust the position of the printed image in Vertical: - 0000* — 1424
both vertical and horizontal directions. This Horizontal — 0000* — 0832
may be useful in aligning the prinedt imageon
preprinted label stock.
Head Check To allow the printer to monitor the print head No* -Disables Head Check
condition. [f this option is enabled, the user
must then enter an interval for the number Yes - Enables Head Check
of labels printed between every print head
check operation. It Yes:
Enter check interval= 0001* — 9999
Loopback Test | To check the printer's RS232C interface betore N/A
attaching to the host. Must use a special
connector. For more details see Section 2,
Interface Specifications, of the Programmer
and Technical Reference Manual.

* SATO factory default
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Section 2 — Setup and Configuration

. SATO'Defaults & User Defaults

Set SATO Set User
Default b Defauit >
ENTER O ENTER ]
& 5y
> l > | I
Are You Sure? Are You Sure? Are You Sure? b Are You Sure? ’
No _ [ [Ye O No g LYes O
ENTER ENTER ENTER ENTER
O ' O d O
finished e o Defaut Or finished E;\t;;‘g)u?daun or
ENTER ENTER
finished finished
When the desired
value is displayed,
press ENTER
Option /| Definition/Purpose = | Values/Settings.

SATO Defaults | To set all current configuration options back
to SATO factory defaults. These are different

I h r-programm faults in Yes — Resets configuration to
option. factory defauls

No* — Does not change current

Note: SATO factory defaults are indicated by
the asterisks throughout the configuration
section.

User Defaults To set all current configurtion options to user No* - Does not change current

programmed defaults. The User Default configuration

configuratin is a storage area on the printer

used for holding a printer configuration Yes — Resets configuration to user
designed especially for the end user's default

application. The user defaults can be stored
by sending a short program to the printer.
(See the Programmer and Technical Reference
Manual, Appendix D). The defaults can then
be placed into the current configuration by
selection this option.

* SATO factory default
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Section 2 — Setup and Configuration

External Signal, Dispense Backfeed, & Password

Mode S:

Set Ext.
Signa! >
1 ] | |
External Signal > External Signal > External Signal > External Signal >
Type 1 D Type 2 D Type 3 D Type 4 D
1 | |
ENTE R'
When the selection you want finished

is displayed, press ENTER

Dispense Set Password
Backieed b
ENTER 0 ENTER
O O
Bad([ged } Bad}hed b ‘ Set New Password b
Yes? O No? O [J | O
ENTE
O
finished ‘finished finished

At this point you will rturn
to Mode S main menu

Option Definition/Purpose Values/Settings
External To select the particular printer output signal Type 1* Ll 3‘6
Signal to drive applicators and other devices Type 2 1 33
from the M-8400S via the | F connector, pin 6 Type 3 _l.___[——— :x
¥
Type 4 ov
Password To set the current password number that allows 000* — 999
access to all Password Protected
Configuration Modes.
Backfeed To allow selection of label backfeed. Yes
No*
* SATO Factory Default
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Section 2 - Setup and Configuration

Mode C

0000
LINE ‘ L|NE
]
OFFLINE | —m — e e e e e e — — —
A 7
ENTER ‘ F1
B : O
' ~agf——— Press Enter
Mode U prevee~ ¥ To Continue

Use arrow keys
change the value
then press ENTER

Enter Password

|
|
|
|
Em* g i
|
|
|

ENTER
[ R W Y
: [ 0
Modet Mode S Mode C
4) 4)
a0 00O
Set Set Set Set
Head Counter ‘ > Cutter Counter ‘ ’ . Life Counter ‘ ’ User Counter ‘ b
OO0 OO 00 aa
Press F1 from any
Mode | option to return
to the Main menu.
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Section 2 — Setup and Configuration

Mode S:
Head, Cutter, Lifetime, & User Counters
See Head > See Cutter Count > See Life Counter > See User Counter »
Counter D D D D
ENTER ENTER ENTER ENTER
Cutter Count Now Lite Counter Now User Job Count > User Total Count }
00000000 00000947 0000 D 00000000 D
ENTER ENTER | |
[ l ENER
finished finished
finished
Pressing ENTER at this
point will return you
to Mode C main menu
Option Definition/Purpose Values/Settings
Head Displays two values: Head Counter Now: |
Counter 1. The install date for the current print head 1. 000000 - 991015 (YYMMDD)
2. The total length the label stock (mm) that 2. 00000000 — 99999999
has passed through the pyint head assembly.
Cutter Not applicable to the M-8400S
Counter
Lifetime Displays the total number of label (of all sizes) Life Counter Now:
Counter that have passed through the print head 0000000 — 99999999
assembly.
User The User Count displays the current number User Job Count:
Counter of labels waiting to print, and the User Total 0000 — 9999
Count display the number of different print
jobs sent to the printer since the last power on. User Total Count:
00000000 — 99999999
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Section 2 — Setup and Configuration

Qty
0000
LINE A une
O an
OFFLINE  |— — — — — — I _____ -
ENTER AH |
O B R { H |
O O |
Mode U | ~atff——=xr Press Enter |
T e P To Continue
> entEm A |
O Oy 70O |
Use arrow keys Enter passw;d ] |
change the value {ooo] [
then press ENTER ENTER |
K i ‘. £
Mode | Mode S Mode C ' Mode M
0] 00 00 n
Copy Memory Set Card Type Clear Memory
Card ‘ b ‘ > Card ‘ >
o0 ood 0
Use arrow keys
change the value
then press ENTER
Press F1 from any
Mode | option to return
to the Main menu.
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Section 2 — Setup and Configuration

*NotApplicable To "S"” Model

Mode M

Copy Memory*, Card Type* & Clear Memory*

will be formatted to properly store and recall

Cl M r
Copy Mermory > Set Card Type > cag Y
ENTER ENTER
ENTER
Ty O = O
Are You Sure? Are You Sure? |
No Yes
ENTER '
- i ] [ [ 1
Put Master Card Set Card Type To > Set Card Type To > Set Card Type > Set Card Type >
& Hit Enter Key Formats/Graphics D Formats Only D To Graphics Only D To Fonts Only D
ENTER l ) | |
ENTER r T T
Put Slave Card Clear Formats b Clear Graphics Ciear Whole >
& Hit Enter Key Only? D Only? D Card? D
ENTER finished  ENTER | | ]
O
Copy Done! Are You Sure? » Are You Sure?
Hit F1 Key Now No D Yes
F1 ENTER
O H
finished
- Option Definition/Purpose Vatues/Settings
Copy Memory | To allow data to be copied from one memory No* — Does not select memory card
Card card to another. copy
Yes - Selects memory card copy
Note: The M-8400 S memory card is an if yes:
optional feature used to provide additional Load the master memory card, and
storage for label formats, graphic images, or press <ENTER>. Then load the blank
downloaded fonts. memory card, and press <ENTER>
Set Card Type To indicate how the optional memory card Formats & Graphics — Card used to

store label formats and custom
graphic images.

Formats Only — Stores label formats
only

Graphics Only — Stores graphic
images only

Fonts Only — Card used to store
downloaded fonts

Clear Memory

Card

To allow stored data to be cleared from the
optional memory card

Clear Formats Only — Clears label
format data

Clear Graphics Only —clears custom
graphic images

Ciear Whole Card — Clears all stored
data from card
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Section 2 — Setup and Configuration

Setup and Accessory Mode

Qry

By tae

OFFLINE

it

Mode T

EN&ER‘ AE

MODE U

Use arrow keys

A

i Fi
O

Press Enter To
Continue

A
*EN&ER 5

NOTE:

After selecting each test label you must
return to the ONLINE state to print it.

change the value %’g: Password
then press ENTER e
ENTER
O F1
Ol
I i X i A
Mode ) > ModeS | ) > ‘Mode C > *:ModeM > Mode T
O O ' | O
ENTER
1701 D
: mm <Test Print>
ENTER X 100mm <_Em Hit Emarrl'r;(ey -
] O
Print > Print Format > Prirt Stored > Print Custom > Print Head
Receive Buffer? D Nos Used? D Graphics? D Designs? D Pattern?
>
, O
Print Buitt-in > Print Vector » Print Printer > Print Bar Codes? >
Fonts? D Fonts? D Setting? D ’ D

Press F1 from any
Mode T option to
return to the Mode T

Main menu.
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Section 2 - Setup and Configuration

Important Notes About Using Mode T

Mode T is operational only when using Standard proto-codes.

The printer must be set to Standard proto-codes (using Mode I) to print the built-in test label formats. If
your application currently uses the Non-standard protocol code set, temporarily set the proto-codes to
Standard prior to selecting a test label to be printed. Set the proto-codes back to Non-standard upon
completion of the printing of the built-in test label formats.

Each built-in test label format within Mode T is automatically printed when the printer is
placed in the on-line state. ,

After selecting a Mode T label format, you must select the on-line state to print the label. Depress the F1
key repeatedly until the LCD displays "OFFLINE." Now press the LINE switch once and your test label will
be printed providing no error conditions exist within the printer. After the selected test label has been
completed the printer is ready to be returned to normal service. To print an additional test label format you
must return to Mode T and make your selection.

All Built-In Test Label Formats Require The Use of 170mm x 100mm (7" x 4") Label Stock.

You must load 170mm long x 100mm wide (7" x 4") label stock and a 4.3" ribbon to print any of the built-in
test label formats. The use of smaller size stock and ribbon will cause printing directly on the platen. THIS
IS NOT RECOMMENDED AND MAY CAUSE DAMAGE TO THE PRINT HEAD! Such damage is not
covered by the warranty.
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Section 2 - Setup and Configuration

TE ModeT: | o
Recewe Buffer,: *Format Numbers, & *Stored Graphics
Print Receive » Print Format ’ Print Stored ’
Butier? O Nos Used? O Graphics? L__l
| !
ENTER Use the arrow keys to
D change the value and
' press ENTER
F1
LINE
Option Definition/Purpose Values/Settings
Print Receive To print a label which includes a hexidecimal N/A
version of the input data received from the host
computer.
Print Format Not applicable to the “S" model. N/A
Nos Used
Print Stored Not applicable to the "S" model. N/A
Graphics
* Not applicable to the "S" model.
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Section 2 — Setup and Configuration

Custom Designs, Head Pattern, & Built-In Fonts

Mode T

Print Custom Print Head Print Built-in
Designs > Platen > Fonts
ENTER ENTER ENTER
0 * O "0 ‘ = = +
finished Enter Print Qty finished
0000
ENTER Use the arrow keys
D to change the value
and press ENTER
F1 finished
O
LINE
Option Definition/Purpose  "Values/Settings
Custom Design | To print all custom characters that have been N/A

stored in memory.

Head Pattern

To print a test label using all of the print head

Enter quantity of labels to print

elements. Also shows the printer's firmware from 0001* to 9999
level and the printer's current data/time
Built-In Fonts To print a test pattern of the seven built-in N/A
fonts (U, S, M, OA, OB, WB, AND WL).
7/93
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Section 2 — Setup and Configuration

T ' — ModeT '
~Vector Fonts, Printer Setting, & Bar Codes
Print Vector Print Printer Print Bar
Fonts > Setting > Codes >
. [ O
ENTER
0 |
]
LINE
Option ! Definition/Purpose - - | - Values/Settings
Vector Fonts To print a test pattern of the SATO vector font. | N/A
Printer Setting To print a list of the current printer configuration | N/A
settings.
Bar Codes To print a sample of the bar code capabilities N/A
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Section 2 — Setup and Configuration

Mode W

Qy
0000

[L:l]NE$ A l1___11NE

OFFLUNE |— = — — — — t _____ 1

TLVE « i

; —f}——— Press Entér
ModeU | ... $#»={ To Continue

E:EER A E

Use arrow keys Enter passw;,d
change the value {000)
then press ENTER ENTER

= _
8 F1

Mode W Mode |
ENTER | 4»
O + OO

<Set Calendar>
Hit Enter Key

ENTER
Ty

YY MM DD hh mm
891 07 19 11 32
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Section 2 — Setup and Configuration

Mode W

"YY MM DD hh mm

N\

91 7 19 11 32

g ——

YY'WMM DD Khh mm:

Use the arrow keys to ‘ b
change the value and
prass ENTER for each D

ENTER

unit.
- Option Definition/Purpose - Values/Settings .
YY To set the year on the printer's internal clock 00-99
MM To set the month on the printer's internal clock | 01 - 12
DD To set the day on the printer's internal clock 01 -31
hh To set the hour on the printer's internal clock 00-23
mm To set the minute on the printer's intemal clock | 00 — 59
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Section 2 - Setup and Configuration

How to Enable Certain Printer Configuration Settings

—

When changing certain printer settings, it is required that the printer be repowered or label stock fed in order for
the new setting to be enabled (i.e., activated). The following chart dispiays which settings are affected by this
requirement.

Mode Setting Requirement

Repower Printer | Feed A Label

U Pitch Offset v

| Interface

Baud Rate

Stop Bits

Parity

Data Bit Length
Protocol

Multi-Drop Address
Receive Buffer Size
Proto-Codes

DO O O N S N N N N

S Sensor v
Pitch Detect
Print Method v
Ribbon Saver v
Cutter Mode v
Dispenser

Pitch Offset (mm, dot)
VH Offset v/
SATO Default v
User Defautt v

Dispenser Backfeed v
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Section 3 — Cleaning and User Maintenance

SECTION 3
CLEANING AND USER MAINTENANCE

INTRODUCTION

In this section you will find instructions for:

ADJUSTING THE PRINT QUALITY (DARKNESS)

NOTE:

7/93

* Adjusting Print Quality (Darkness)

* Cleaning the Print Head, Platen, and Rollers
* Replacing the Print Head

¢ Replacing the main power fuse

The print quality you will achieve with the M-8400S is a function of 1) proper selection of

printing parameters and 2) cleanliness of the printer. In this section you will learn how to
optimize performance for each label stock and ribbon type you use by selecting the correct
parameters. A subsequent section will detail the cleaning procedures to be followed.

It is assumed that the label stock and ribbons loaded in the printer meet or exceed the
minimum SATO recommendations. If you are unsure of their compatibility, check with your
supplier; be sure to provide him with the exact model designation of the printer (M-84008S /6,
M-84008S /8) and a description of the application.

Optimum print quality is evidenced by even print density and clear crisp edges on bar code
symbols, alpha-numeric characters, and graphic elements. It is also evidenced by
consistently high "first read rates" with your bar code scanner.

The first factor affecting print quality is print darkness. With the M-8400S you may set the
print darkness via input through the OCP in Mode U. Print darkness may also be controlled
from the host system by imbedding the appropriate command in the data sent to the printer.

Print darkness commands received from the host system will always override those
selected via the OCP.

To select the print darkness via input from the OCP, select Mode U and proceed to the Print
Darkness menu following the information in the preceeding section of this Operator’s
Manual (Section 2). Using the P and < keys, select the desired numerical value for print
darkness. The value 1 is the lightest selection; 5 is the darkest selection. If you have
interrupted a print job to adjust print darkness, the printer's input buffer will contain the
data used for printing the previous label. Pressing the ENTER switch at this time will cause
the M-8400S to print one additional label using this data. Use this feature after each new
selection of darkness to examine the effect it has on your label. Under most circumstances
one of these selections will produce the required print quality. If the required print quality
cannot be achieved simply by selecting the darkness value, a change of print speed may also
be required.
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Section 3 — Cleaning and User Maintenance

Details for incorporating the print darkness command into the data from the host are located
in the M-8400S Programmer and Technical Reference Manual.

For additional, fine adjustment of the print quality use the PRINT as outlined below:

Using a 1/8" standard screwdriver, rotate the control identified as PRINT control clockwise
for darker print and counterclockwise for lighter print. (This control is much like the volume
control on a radio; its full rotational range is 270°. Do not, force it to rotate bevond the
stops.) The setting of this control will interact with the print darkness selection made above,
the darkness command in the data and print speed.

If you are unable to achieve the required print quality by following these guidelines consult
with your service department. No additional user adjustments are available. Mechanical
adjustments of the printer should be carried out only by trained service personnel using the
recommended procedures and tools.

CLEANING THE PRINT HEAD

With time and use, label adhesive, ribbon residue, and paper dust will build up on the active
surface of the print head. If allowed to accumulate it will eventually reduce the print quality
to the point at which voids will appear in the printed image. It will also drastically reduce
print head life.

. Completion of'this proeedure is recommended whenever the ribbon is replaced.

Use of chemicals and materials other than those in the SATO Print Head Cleaning Kit

(P/N SA070) to clean the print head may result in damage to the print head and void your
warranty. The active surface of the print head is actually a very thin glass material. Under
no circumstances should a hard, sharp object be used to scrape foreign matter from the print
head surface or from any other surface in the printer. If the glass surface of the print head is
damaged it cannot be repaired; the print head must be replaced.

STEP ACTION

1 Set the printer's main power switch to the OFF (0) position.

2 Raise the front cover to the full upright position.

3 Rotate the Print Head Lock lever to the open position.

4 If a ribbon is loaded, remove it from the label path. It is not necessary to completely remove
the ribbon from the printer.

5 Remove the label stock from the area of the print head.

6 Moisten a cotton swab with SATO THERMAL PRINTHEAD & PLATEN CLEANER and
remove all label adhesive, ribbon residue, and paper which may have accumulated on the
print head. You may be required to scrub with the swab to remove stubborn deposits.
Repeat as necessary until all foreign material is removed.
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Section 3 — Cleaning and User Maintenance

7 Dry the print head with a Clean Wipe from the cleaning kit.

8 Reposition/load the ribbon.

9 Reposition the label stock.

10 Rotate the Print Head Lock lever to the closed and locked position.
11 Lower the front cover to the closed position.

12 Set the printer's main power switch to the ON (1) position.

The same label adhesive, ribbon residue, and paper dust which collected on the active surface
of the print head may also build up on the platen and rollers in the M-8400S. If allowed to
accumulate, it will reduce the print quality and cause label feed problems.

Completion of this procedure is recommended whenever the ribbon is replaced.

Use of chemicals and materials other than those in the SATO Print Head Cleaning Kit

(P/N SAO070) to clean the platen and rollers may result in damage and void your warranty.
Under no circumstances should a hard, sharp object be used to scrape foreign matter from
the platen or from any other surface in the printer. If the surface of the platen is damaged it
cannot be repaired; it must be replaced.

STEP ACTION

1 Set the printer's main power switch to the OFF (0) position.

2 Raise the front cover to the full upright position.

3 Rotate the Print Head Lock lever to the full open position.

4 Remove both ribbon and label stock from the printer.

5 Moisten a cotton swab with SATO PRINTHEAD & PLATEN CLEANER and remove all

adhesive, ribbon residue, and paper dust from the platen, demand plate, and rollers within
the M-8400S. You may be required to scrub with the swab to remove stubbon deposits.
Manually rotate the ribbon wind shaft to access the complete surfaces of the platen and
rollers. Repeat as necessary until all surfaces are clean and free of deposits.

6 Dry the platen, demand plate, and rollers with a Clean Wipe from the kit.
7 Reload ribbon and label stock.
8 Rotate the Print Head Lock lever to the closed and locked position.
9 Lower the front cover to the closed position.
10 Return the printer’'s main power switch to the ON (1) position.
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Section 3 - Cleaning and User Maintenance

REPLACING THE PRINT HEAD

While the print head in the M-8400S has a very long life, it is a consummable item and
requires replacement periodically. Removal and replacement is a simple operation easily
accomplished in minutes by the operator. Replacement print heads are available from your
applicator system vendor. In high duty cycle applications you may consider keeping a new
print head on hand to minimize disruption to production when the present head requires
replacement.

The only tool required to successfully remove and replace the print head is a No. 2 Phillips
screwdriver. The task will go much easier if the screwdriver has a magnetized tip to hold the
screws.

STEP ACTION

1 Set the printer's main power switch to the OFF (0) position.

2 Raise the front cover to the full upright position.

3 Remove ribbon and label stock from the print area.

4 Rotate the Print Head Lever to the CLOSED position.

5 Carefully remove and retain the three (3) screws and washers shown in Figure 3-1.

.NOTE: - DO NOT LOOSEN OR REMOVE THE TWO (2) LARGER SCREWS LOCATED
BEHIND THE THREE SHOWN IN FIGURE 3-1. REMOVAL/LOOSENING OF THESE
SCREWS WILL REQUIRE A TRAINED SERVICE TECHNICIAN TO RESTORE
PROPER OPERATION.

6 Remove and retain the Ribbon Guide Plate.

7 Rotate the Print Head Lever to the OPEN position.

8 Carefully unplug the print head from the connector.

9 Replace the print head by first pluging it into the connector.

Caution: Be very careful not to scratch the printing surface of the print head during
installation. Scratches on the surface are permanent, irreparable and cause print
voids.. Such damage is not covered by the warranty.

10 Hold the Print Head aligned with the Print Head Mounting Plate and rotate the Print Head
Lever to the CLOSED position.

11 Replace the Ribbon Guide Plate.

12 Replace the three screws removed in step 5 above. Tighten securely.

13 Reload ribbon and label stock.

14 Reset the printer's main power switch to the ON (1) position.
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Section 3 — Cleaning and User Maintenance

Remove these 3 screws
and washers

N
% \__ Note: Short screw in
N

center position
Print Head

Mounting Plate \

Ribbon Guide
Plate

Print Head

Figure 3-1. Removing The Print Head

REPLACING THE MAIN POWER FUSE

The circuitry within the M-84008S is protected from a current overload by a fast blow fuse.
Should the printer fail to operate, the condition of this fuse should be checked; if it is open
the cause of the overload condition must be determined and corrected prior to replacing the
fuse. NEVER replace the fuse with one of a greater amperage rating - the specified rating
has been selected to prevent damage and/or injury.

STEP ACTION

1 Set the printer's main power switch to the OFF (0) position.

2 Disconnect the A-C power cable from the rear of the printer.

3 Locate the fuse holder assembly in Figure 3-2.

4 Gently press down on the fuse holder cover while pulling away from the printer.

No tools are required.
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Section 3 — Cleaning and User Maintenance

5 Extend the fuse holder to the full open position.
6 Remove the main power fuse.
7 Replace the main power fuse with one having the exact same rating. (A spare fuse is

included with the printer and can be found in the cover of the fuse holder.)

8 Gently press the fuse holder assembly into the printer until it "clicks” into place.
9 Reconnect the A-C power cable removed in step 2 above.
10 Set the printer's main power switch to the ON (1) position. Providing the cause of the

overload condition has been corrected, full operation of the printer should resume. If full
operation does not return consult your service department. No additional user service
procedures are available.

___——— Main Power Fuse Holder

~ A-C Power Cable Socket

Applicator I/F Connector RS-232 Connector

Centronics Connector

Figure 3-2. Rear View of M-8400S
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